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■ Introduction 
This replacement guide assumes replacement of the CP1E with the CP2E and no changes to the operation 
or functions. 
The contents include references for selection, configuration of settings, and wiring. No precautions for 
correct use are included. Be sure to obtain the user’s manuals for both the source and target replacement 
models, and refer to these manuals for necessary usage information—including precautions for correct 
use—and for verifying operation is satisfactory. 

 
■ Intended Audience 

This guide is intended for the following personnel, who must also have knowledge of electrical systems (an 
electrical engineer or the equivalent). 
• Personnel in charge of introducing FA devices. 
• Personnel in charge of designing FA systems. 
• Personnel in charge of managing FA facilities. 

  



  
 

Terms and Conditions Agreement 
Read and understand this catalog. 
Please read and understand this catalog before purchasing the products.  Please consult your OMRON 
representative if you have any questions or comments.   
 
Warranties. 
(a) Exclusive Warranty. Omron’s exclusive warranty is that the Products will be free from defects in 
materials and workmanship for a period of twelve months from the date of sale by Omron (or such other 
period expressed in writing by Omron). Omron disclaims all other warranties, express or implied. 
(b) Limitations. OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, 
ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE 
OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE 
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR INTENDED USE. 
Omron further disclaims all warranties and responsibility of any type for claims or expenses based on 
infringement by the Products or otherwise of any intellectual property right.  
(c) Buyer Remedy. Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the 
form originally shipped with Buyer responsible for labor charges for removal or replacement thereof) the 
non-complying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer an amount 
equal to the purchase price of the non-complying Product; provided that in no event shall Omron be 
responsible for warranty, repair, indemnity or any other claims or expenses regarding the Products 
unless Omron’s analysis confirms that the Products were properly handled, stored, installed and 
maintained and not subject to contamination, abuse, misuse or inappropriate modification. Return of any 
Products by Buyer must be approved in writing by Omron before shipment. Omron Companies shall not 
be liable for the suitability or unsuitability or the results from the use of Products in combination with any 
electrical or electronic components, circuits, system assemblies or any other materials or substances or 
environments. Any advice, recommendations or information given orally or in writing, are not to be 
construed as an amendment or addition to the above warranty. 
See http://www.omron.com/global/  or contact your Omron representative for published information. 
 
Limitation on Liability; Etc. 
OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN 
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN CONTRACT, 
WARRANTY, NEGLIGENCE OR STRICT LIABILITY. 
Further, in no event shall liability of Omron Companies exceed the individual price of the Product on 
which liability is asserted. 
 
Suitability of Use. 
Omron Companies shall not be responsible for conformity with any standards, codes or regulations 
which apply to the combination of the Product in the Buyer’s application or use of the Product. At Buyer’s 
request, Omron will provide applicable third party certification documents identifying ratings and 
limitations of use which apply to the Product. This information by itself is not sufficient for a complete 
determination of the suitability of the Product in combination with the end product, machine, system, or 
other application or use. Buyer shall be solely responsible for determining appropriateness of the 
particular Product with respect to Buyer’s application, product or system. Buyer shall take application 
responsibility in all cases.  
NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR 
PROPERTY OR IN LARGE QUANTITIES WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE 
HAS BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS 



  
 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL 
EQUIPMENT OR SYSTEM. 
 
Programmable Products. 
Omron Companies shall not be responsible for the user’s programming of a programmable Product, or 
any consequence thereof. 
 
Performance Data. 
Data presented in Omron Company websites, catalogs and other materials is provided as a guide for the 
user in determining suitability and does not constitute a warranty. It may represent the result of Omron’s 
test conditions, and the user must correlate it to actual application requirements. Actual performance is 
subject to the Omron’s Warranty and Limitations of Liability. 
 
Change in Specifications. 
Product specifications and accessories may be changed at any time based on improvements and other 
reasons. It is our practice to change part numbers when published ratings or features are changed, or 
when significant construction changes are made. However, some specifications of the Product may be 
changed without any notice. When in doubt, special part numbers may be assigned to fix or establish 
key specifications for your application. Please consult with your Omron’s representative at any time to 
confirm actual specifications of purchased Product. 
 
Errors and Omissions. 
Information presented by Omron Companies has been checked and is believed to be accurate; however, 
no responsibility is assumed for clerical, typographical or proofreading errors or omissions. 
  

Microsoft products screen shot(s) reprinted with permission from Microsoft Corporation. 
Other company names and product names in this document are the trademarks or registered trademarks of their 
respective companies. 



  
 

■ Related Manuals 
Man. No. Model Manual 
W479  
(CP1E) 

CP1E-ESD- 
CP1E-NSD- 
CP1E-ED- 
CP1E-ND- 
CP1E-NAD- 

CP1E CPU Unit Hardware User’s Manual 
 

W480 
(CP1E) 

CP1E-ESD- 
CP1E-NSD- 
CP1E-ED- 
CP1E-ND- 
CP1E-NAD- 

CP1E CPU Unit Software User’s Manual 
 

W613 
(CP2E) 

CP2E-ED- 
CP2E-SD- 
CP2E-ND- 

CP2E CPU Unit Hardware User’s Manual 
 

W614 
(CP2E) 

CP2E-ED- 
CP2E-SD- 
CP2E-ND- 

CP2E CPU Unit Software User’s Manual 
 

W483 
(For both CP1E and CP2E) 

CP1E-ED- 
CP1E-ND- 
CP2E-ED- 
CP2E-SD- 
CP2E-ND- 

CP1E/CP2E CPU Unit Instructions Reference 
Manual 
 

W446 CXONE-ALD-V4 CX-ProgrammerVer.9.  
Operation Manual 
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Replacement flow 
The procedure to replace the CP1E with the CP2E is as follows. (Each number shows the number of the 
section) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Precautions for Correct Use 
● This guide provides the procedure to replace the CP1E with the CP2E. However, there are 

differences in functions and performance between these two models, and not all CP1E can be 
replaced with the CP2E. Please refer to this guide and the manuals to examine replacement 
carefully. 

● After replacement, please perform trial operation before starting actual operation and check 
that the system operates correctly. This guide does not include sufficient specifications for 
replacement. Please refer to the manuals listed on the Related Manuals page and check the 
specifications before continuing. 

 
 

3. Replace the CP1E with the CP2E, and complete 
the wiring. 

4. Convert the programs and settings. 
Change from the CP1E model to the CP2E model. 
Check the error and caution reports, and correct 
the program if necessary. 
Check the PLC Setup settings. 

1. Confirm the target replacement model. 
Select the model to be used for replacement. 

2. Check the specifications—including the external 
dimensions and wiring—for differences from the 
main CP1E and the CP2E specifications. 
Check the external dimensions, wiring, and other 
information. 

5. Transfer the converted program, settings, and data 
to the CP2E. 

6. Perform a test operation. 
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1. Replacement Model Confirmation 
 
< Precaution for replacement > 
Note that the dimensions, specifications, programs, settings, terminal arrangements, and other aspects 
may be changed by replacing the CP1E with the CP2E. Please refer to this replacement guide and the 
user’s manuals of the CP1E and CP2E for details. 
 
 
● Using CP1E-E(S)DR-A 

Replace with CP2E-EDR-A. 
Model being replaced: 
CP1E-E/ES 

Model used for replacement: CP2E-E 

CP1E-E10D□-□ CP2E-E14DR-A 
CP1E-E14DR-A/E14SDR-A CP2E-E14DR-A 
CP1E-E20DR-A/E20SDR-A CP2E-E20DR-A 
CP1E-E30DR-A/E30SDR-A CP2E-E30DR-A 
CP1E-E40DR-A/E40SDR-A CP2E-E40DR-A 
CP1E-E60DR-A/E60SDR-A CP2E-E60DR-A 

*: No 10-point CPU Unit is available for the CP2E. Replace with a 14-point CPU Unit. 
 
● Using CP1E-NSD- 

Replace with CP2E-SD-. 
Model being replaced: CP1E-NS Model used for replacement: CP2E-S 
CP1E-N30SD- CP2E-S30D- 
CP1E-N40SD- CP2E-S40D- 
CP1E-N60SD- CP2E-S60D- 

 
● Using CP1E-NS1D- 

Replace with CP2E-SD-. 
Model being replaced: CP1E-NS1 Model used for replacement: CP2E-S 
CP1E-N30S1D- CP2E-S30D- 
CP2E-N40S1D- CP2E-S40D- 
CP2E-N60S1D- CP2E-S60D- 
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● Using CP1E-ND- 

 
Model being replaced: 
CP1E-N 

Model used for replacement: 
CP2E-S 

Model used for replacement: 
CP2E-N 

CP1E-N14D- - CP2E-N14D- 
CP1E-N20D- - CP2E-N20D- 
CP1E-N30D- CP2E-S30D- CP2E-N30D- 
CP1E-N40D- CP2E-S40D- CP2E-N40D- 
CP1E-N60D- CP2E-S60D- CP2E-N60D- 

 
*: Replacing the communication port with the Option Board 

(1) The CP2E-N does not have a built-in RS-232C port.  
If an RS-232C communication port is necessary, mount the RS-232C Option Board CP1W-CIF01 
on the CP2E-N. 

(2) If using the CP1W-CIF41 Ethernet Option Board, replace the CP1W-CIF41 with the CP2E-N 
Built-In Ethernet Port. The CP1W-CIF41 cannot be mounted on the CP2E-N.  
Refer to Appendix 3. PC System Setting Examples for Transitioning from CP1W-CIF41 to 
CP2E-N for replacing the settings when using the CP1W-CIF41. 

(3) All other Option Boards that can be mounted to the CP1E-N can be used with the CP2E.  
CP1W-CIF01/CP1W-CIF11/CP1W-CIF12-V1  
CP1W-ADB21/CP1W-DAB21V/CP1W-MAB221 

*: No CP2E-N replacement models exist for transistor output/AC power supply CP1E-N models 
(CP1E-NDT/DT1-A). Replace with a transistor output/DC power supply model 
(CP2E-SDT/DT1-D or CP2E-NDT/DT1-D). 

 
  

 

Replace with 
CP2E-N 

Replace with 
CP2E-S 

No 

Yes 

Yes 

No 

 

Is an Option Board being used? 

Yes 

No Is the CPU Unit a 30-, 40-, 
or 60-point unit? 

Is the ER/DR signal of the  
RS-232C port being used? 

Yes 

Is the CPU Unit an  
AC power supply relay output unit? 
Is the CPU Unit a DC power supply 

transistor output unit? 

 

No 
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● Using CP1E-NA20D- 
No direct replacement models are available. 
Use the following combinations as equivalent configurations. 
 

Model being replaced: 
CP1E-NA20D- 

Model used for replacement: CP2E + Analog unit 

CP1E-NA20D- 
Inputs: 12, Outputs: 8 
Analog inputs: 2 (isolated) 

Input range: 0 to 5 V, 1 to 5 V, 0 to 10 V, 
-10 to +10 V, 0 to 20 mA,  
4 to 20 mA 

Resolution: 6,000 
Analog outputs: 1 (isolated) 

Output range: 0 to 5 V, 1 to 5 V, 0 to  
10 V, -10 to +10 V,  
0 to 20 mA, 4 to 20 mA 

Resolution: 6,000 

CP2E-S30D- or CP2E-N30D- 
Inputs: 18, Outputs: 12 

CP1W-MAD11 (Analog Input/Output Expansion Unit) 
Analog inputs: 2 (isolated) 

Input range: 0 to 5 V, 1 to 5 V, 0 to 10 V, -10 to +10 V 
0 to 20 mA, 4 to 20 mA 

Resolution: 6,000 
Analog outputs: 1 (isolated) 

Input range: 0 to 5 V, 1 to 5 V, 0 to 10 V, -10 to +10 V 
0 to 20 mA, 4 to 20 mA 

Resolution: 6,000 
Model used for replacement:  
CP2E + Analog Option Board 
CP2E-N30D- 

Inputs: 18, Outputs: 12 
CP1W-MAB221 (Analog Option Board) 

Analog inputs: 2 (non-isolated) 
Input range: 0 to 10 V, 0 to 20 mA 
Resolution: 4,000 (0 to 10 V); 2,000 (0 to 20 mA) 

Analog outputs: 1 (non-isolated) 
Input range: 0 to 10 V 
Resolution: 4,000 

*: When using the CP1W-MAB221, the analog I/O range is limited, and the internal circuits of the analog 
I/O and the CPU Unit are not isolated. 
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2. Main Specifications and Differences Between CP1E and CP2E 
2.1. Dimensions 

Although the dimensions of the CP1E and the CP2E are different, the two models are almost identical. 
*: No 10-point CPU Unit is available for the CP2E. Replace with a CPU Unit with 14 points or more. 
 
Dimension comparison table 

I/O points Dimensions (W x H x D) 
CP1E-E 
CP1E-N 
Normal-type 

CP1E-ES 
CP1E-NS(1) 

Renewal-type 

CP2E 

10 points 66×90×85 - - 
14 points 86×90×85 86×90×79 86×90×80 
20 points 86×90×85 86×90×79 86×90×80 
30 points 130×90×85 130×90×79 130×90×80 
40 points 150×90×85 150×90×79 150×90×80 
60 points 195×90×85 195×90×79 195×90×80 

 
2.2. Mounting 

The DIN track and screw hole dimensions are the same as for the CP1E. 
I/O points Mounting hole pitch A 

CP1E CP2E 
10 points 56±0.5 - 
14 points 76±0.5 76±0.5 
20 points 76±0.5 76±0.5 
30 points 120±0.5 120±0.5 
40 points 140±0.5 140±0.5 
60 points 185±0.5 185±0.5 

 
 

2.3. Expansion (I/O) Units 
All CP1W Expansion (I/O) Units connectable to the CP1E can be used with the CP2E. 
 

2.4. Option Boards 
The CP1W-CIF41 cannot be used with the CP2E. If using the CP1W-CIF41 with the CP1E, use the built-in 
Ethernet port of CP2E-N. 

 
2.5. Supply Voltage 

Although the power supply voltage and operating voltage range of the CP1E and CP2E are the same, the 
power consumption increases depending on the model. 
Change to an appropriate power supply if power supply capacity is insufficient. 

 
2.6. External Power Supply 

The external power supply specifications of the CP1E and CP2E are the same. 
Only 30/40/60-point AC power supply models include an external power supply function. 
 

2.7. I/O Function Assignment 
All CP1E functions have been covered with the CP2E, with some functions including enhancements. This 
eliminates the need to implement changes when replacing the models. 

  

CP1E/CP2E 
CPU Unit 

100 mm 

8 mm 
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(1) Input interrupt, quick-response input function 
Function assignments have not been changed. The CP2E-N□□ includes an increased number of interrupt 
inputs and quick-response inputs. 

Contact function assignments 
Input contact CP1E CP2E 

CP2E-S/E, CP2E-N14 CP2E-N20/30/40/60 
0.02 Interrupt input 2/ 

Quick-response input 2 
Interrupt input 2/ 
Quick-response input 2 

Interrupt input 2/ 
Quick-response input 2 

0.03 Interrupt input 3/ 
Quick-response input 3 

Interrupt input 3/ 
Quick-response input 3 

Interrupt input 3/ 
Quick-response input 3 

0.04 Interrupt input 4/ 
Quick-response input 4 

Interrupt input 4/ 
Quick-response input 4 

Interrupt input 4/ 
Quick-response input 4 

0.05 Interrupt input 5/ 
Quick-response input 5 

Interrupt input 5/ 
Quick-response input 5 

Interrupt input 5/ 
Quick-response input 5 

0.06 Interrupt input 6/ 
Quick-response input 6 

Interrupt input 6/ 
Quick-response input 6 

Interrupt input 6/ 
Quick-response input 6 

0.07 Interrupt input 7/ 
Quick-response input 7 

Interrupt input 7/ 
Quick-response input 7 

Interrupt input 7/ 
Quick-response input 7 

0.08 － － Interrupt input 8/ 
Quick-response input 8 

0.09 － － Interrupt input 9/ 
Quick-response input 9 

 
(2) High-speed counter input function changes 
Although the max. input frequency has been increased, function assignments have not been changed. 

Max. input frequency 
High-speed 
counter 

CP1E-E(S) CP1E-N(S) CP2E-S/E CP2E-N 

High-speed 
counter 0 

Increment pulse: 10 kHz 
Increment/decrement 
pulse: 10 kHz 
Pulse + direction: 10 kHz 
Phase difference: 5 kHz 

Increment pulse: 100 kHz 
Increment/decrement 
pulse: 100 kHz 
Pulse + direction: 100 kHz 
Phase difference: 50 kHz 

Increment pulse: 100 kHz 
Increment/decrement 
pulse: 100 kHz 
Pulse + direction: 100 kHz 
Phase difference: 50 kHz 

Increment pulse: 100 kHz 
Increment/decrement pulse: 
100 kHz 
Pulse + direction: 100 kHz 
Phase difference: 50 kHz 

High-speed 
counter 1 

Increment pulse: 10 kHz 
Increment/decrement 
pulse: 10 kHz 
Pulse + direction: 10 kHz 
Phase difference: 5 kHz 

Increment pulse: 100 kHz 
Increment/decrement 
pulse: 10 kHz 
Pulse + direction: 100 kHz 
Phase difference: 5 kHz 

Increment pulse: 100 kHz 
Increment/decrement 
pulse: 10 kHz 
Pulse + direction: 100 kHz 
Phase difference: 5 kHz 

N30/40/60  
Increment pulse: 100 kHz 
Increment/decrement pulse: 
100 kHz 
Pulse + direction: 100 kHz 
Phase difference: 50 kHz 

N14/20 
Increment pulse: 100 kHz 
Increment/decrement pulse: 
10 kHz 
Pulse + direction: 100 kHz 
Phase difference: 5 kHz 

High-speed 
counter 2 

Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 100 kHz 

High-speed 
counter 3 

Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz 

High-speed 
counter 4 

Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz 

High-speed 
counter 5 

Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz Increment pulse: 10 kHz 

 
Contact function assignments 
Input contact For both CP1E and CP2E 

Increment pulse Differential phase or up/down Pulse + direction 
0.00 High-speed counter 0 High-speed counter 0 (phase A/increment) High-speed counter 0 (pulse) 
0.01 High-speed counter 1 High-speed counter 0 (phase B/decrement) High-speed counter 1 (pulse) 
0.02 High-speed counter 2 High-speed counter 1 (phase A/increment) High-speed counter 0 (direction) 
0.03 － High-speed counter 1 (phase B/decrement) High-speed counter 1 (direction) 
0.04 High-speed counter 3 High-speed counter 0 (phase Z/reset) High-speed counter 0 (reset) 
0.05 High-speed counter 4 High-speed counter 1 (phase Z/reset) High-speed counter 1 (reset) 
0.06 High-speed counter 5 － － 
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(3) Using pulse outputs 
Although the number of pulse output points has been increased, function assignments have not been 
changed. 
 

Contact function assignments 
Output 

Output contact CP1E-N(S) CP2E 
CP2E-S CP2E-N 

100.00 Pulse output 0 (pulse) Pulse output 0 (pulse) Pulse output 0 (pulse) 
100.01 Pulse output 1 (pulse) Pulse output 1 (pulse) Pulse output 1 (pulse) 
100.02 Pulse output 0 (direction)  Pulse output 0 (direction)  Pulse output 0 (direction)  
100.03 Pulse output 1 (direction) Pulse output 1 (direction) Pulse output 1 (direction) 
100.04 Pulse output 0 

Error counter reset output 
Pulse output 0 
Error counter reset output 

Pulse output 0 
Error counter reset output 

100.05 Pulse output 1 
Error counter reset output 

Pulse output 1 
Error counter reset output 

Pulse output 1 
Error counter reset output 

100.06 - - Pulse output 2 
Error counter reset output 

100.07 - - Pulse output 3 
Error counter reset output 

101.00 - - Pulse output 2 (pulse) 
101.01 - - Pulse output 3 (pulse) 
101.02 - - Pulse output 2 (direction) 
101.03 - - Pulse output 3 (direction) 
 

Input (N20/30/40/60, S20/30/40/60 CPU Unit: With origin searching) 
Input contact CP1E-N(S) CP2E 

CP2E-S CP2E-N 
0.06 Pulse output 0 origin input Pulse output 0 origin input Pulse output 0 origin input 
0.07 Pulse output 1 origin input Pulse output 1 origin input Pulse output 1 origin input 
0.08 - - Pulse output 2 origin input 
0.09 - - Pulse output 3 origin input 
0.10 Pulse output 0 origin proximity input Pulse output 0 origin proximity 

input 
Pulse output 0 origin proximity input 

0.11 Pulse output 1 origin proximity input Pulse output 1 origin proximity 
input 

Pulse output 1 origin proximity input 

1.00 - - Pulse output 2 origin proximity input 
1.01 - - Pulse output 3 origin proximity input 
*1: The pulse output function cannot be used with relay output models. 
*2: Pulse outputs 2 and 3 can be used with N30/40/60 CPU Units. 
 

Input (N14 CPU Unit: With origin searching) 
Input contact CP1E-N14 CP2E 

- CP2E-N14 
0.03 Pulse output 0 origin proximity input - Pulse output 0 origin proximity input 
0.04 - - - 
0.05 Pulse output 1 origin proximity input - Pulse output 1 origin proximity input 
0.06 Pulse output 0 origin input - Pulse output 0 origin input 
0.07 Pulse output 1 origin input - Pulse output 1 origin input 
*1: The pulse output function cannot be used with relay output models. 
 

(4) Using the PWM output function 
The specifications are the same for both the CP1E and the CP2E. No changes have been implemented. 

Output contact CP1E CP2E 
100.01 PWM output 0 PWM output 0 
*: The PWM output function cannot be used with relay output models. 
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2.8. Battery 
The CP1E and the CP2E use different batteries. 

CP1E: CP1W-BAT01 (sold separately) 
CP2E: CP2W-BAT02 (sold separately) 

The battery/capacitor backup areas are different between the CP1E and the CP2E. 
When using the CP1E I/O memory backup battery, installation of a separate battery is not required. 

Battery/capacitor backup area 
 CP1E CP2E 
I/O memory 
• DM Area (D) 
• Holding Area (H) 
• Current counter value/counter flag (C) 
• Auxiliary Area 

Battery/capacitor backup -  
(Battery-less backup is performed 
even when the power is OFF, so no 
battery is required.) 

Clock Battery/capacitor backup 
(For CP1E-N(S)) 

Battery/capacitor backup 
(For CP2E-S/CP2E-N) 

 
2.9. Analog Adjusters 

The CP2E does not have an analog adjuster function. 
Change how the function is implemented, such as by creating programmable terminal screens. 
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3. Wiring 
 
3.1. Terminal Arrangement 

The terminal block is fixed for both the CP1E and the CP2E. 
● Input wiring 

Same for both the CP1E and the CP2E. 
 

● Output wiring 
Relay output model 

Same for both the CP1E and the CP2E. 
Transistor output 

Depending on the model used for replacement, some wiring may need to be changed. 
Model being replaced: CP1E-NS Model used for replacement: CP2E-S 
 
 

Sinking Sourcing 
 

 
 

 

 
 

No change 
 
Model used for replacement: CP2E-N 
Supplying 24 VDC power to the 100CH00 bit/01 bit 
is not necessary. 

Sinking Sourcing 
 

 
 

 

 
 

 

 
Model being replaced: CP1E-N Model used for replacement: CP2E-S 
 
 

Sinking Sourcing 
 

 
 

 

 
 

 

An external supply of 24 VDC power is required 
when using the 100CH00 bit/01 bit. 

Sinking Sourcing 
 

 
 

 

 
 

Model used for replacement: CP2E-N 
No change 
 

 
  

Power supply from external source Power supply from external source 

Power supply from external source Power supply from external source 
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3.2. Communication Port Wiring 
● Built-in RS-232C port 
The interface of the built-in RS-232C port on the CP1E is different from the built-in RS-232C port on the 
CP2E-S/E. 
Change the wiring. 

Model being replaced: CP1E-N(S) Model used for replacement: CP2E-S/E 
D-sub connector 

 Pin 
No. 

Signal name 
CP1E 
NS 

CP1E 
N 

 

 

1 FG FG 
2 SD(TXD) SD(TXD) 
3 RD(RXD) RD(RXD) 
4 RS(RTS) RS(RTS) 
5 CS(CTS) CS(CTS) 
6 5V 5V 
7 - DR(DSR) 
8 - ER(DTR) 
9 SG(0V) SG(0V) 
Shell FG FG 

 
 

Terminal block 
 Pin 

No. 
Signal name 
CP2E-S/E 

 

 
 

1 SD(TXD) 
2 RD(RXD) 
3 RS(RTS) 
4 CS(CTS) 
5 SG(0V) 
6 FG 

 
 
 
 
 
 
Model used for replacement: CP2E-N + 
Option Board CP1W-CIF01 
D-sub connector 

 Pin 
No. 

Signal name 
CP1E-N 

 

 

1 FG 
2 SD(TXD) 
3 RD(RXD) 
4 RS(RTS) 
5 CS(CTS) 
6 5V 
7 DR(DSR) 
8 ER(DTR) 
9 SG(0V) 
Shell FG 

 
● Built-in RS-485 port 
The wiring for the built-in RS-485 port of the CP1E-NS1 and the built-in RS-485 port of the CP2E-S 
is the same. 
 

3.3. Expansion Unit and Option Board Wiring 
Expansion Units and Option Boards can be replaced as they are. 
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4. Changing Programs and Settings Using CX-Programmer 
Use CX-Programmer to change programs and settings from the CP1E to the CP2E. 
Use CX-Programmer version 9.72 or later. 
 
4.1. Saving CP1E Programs and Settings 
If programs must be transferred from the CP1E being replaced, use CX-Programmer to save the necessary 
CP1E programs. 
 
4.1.1. Saving User Programs 

From the menu, click PLC → Transfer → Transfer From PLC, and check all of the boxes as in the 
following diagram. After the user programs or PLC Setup settings are transferred to the project, save the 
project. 

 
 

4.1.2. Saving I/O Memory 
When the data for the ladder program is set in the I/O memory (DM Area and Holding Area) of the CP1E, it 
is necessary to copy it to the I/O memory area of the CP1E. Follow the procedure below to save a .mem 
file. 
(1) Memory 
(2) Open D/H 
(3) Online → Transfer From PLC 
(4) File → Save to File 
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4.2. Converting program 
Changing the PLC 
Change the PLC model in the CP1E user program from “CP1E” to “CP2E” or “CP2E-N” with the 
CX-Programmer. 
Also set the CPU model. 

 
 

4.3. Checking error and warning report 
Check for errors after converting to the CP2E. 

 
Select Program → Compile to check the program. 

 
 
If the Output window shows errors or warnings, check the details for each. 
 
If a ladder rung contains an error, a red line appears down the left-hand side of the rung. 
 
 

 
 
Compile can check the following contents. 

• Illegal data 
• Instruction support by PLC 
• Operand ranges 
• Program capacity for PLC 
• Syntax 
• Ladder diagram structure 
• Output duplication 
• Tasks  
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4.4. Modifying Program 
If an error occurs, correct the error while referring to the CP2E CPU Unit User’s Manual, the CP1E CPU 
Unit User’s Manual, and the CP1E/CP2E Instructions Reference Manual. 

Precautions for Correct Use 
Some errors may not be detected by the above-mentioned check with Compile. 
Check the entire program to ensure there are no problems with the system, and modify as 
necessary. 

 
 

4.5. PLC Setup Changes 
Depending on the CP2E model being used for replacement, the CP1E PLC Setup settings may not be 
transferred. Open the PLC Setup settings for the CP2E, and configure the settings manually. Make sure 
that the PLC Setup settings have been changed correctly. 
 
When changing models as follows, the PLC Setup settings will be transferred when the PLC model is 
changed. 

Model being replaced: CP1E Model used for replacement: CP2E Transferring PLC Setup settings 
CP1E-E CP2E-E Carried over 

CP2E-S, CP2E-N Cannot be carried over 
CP1E-N CP2E-E Cannot be carried over 

CP2E-S, CP2E-N Carried over 
Models other than CP1E 
CS/CJ/CP1H/CP1L 

CP2E-E, CP2E-S, CP2E-N Cannot be carried over 

   *: The PLC Setup settings are not transferred even when changing from the CP2E to a different model. 
 
5. Transferring Data 

Transfer the programs, settings, and data that have been converted or modified to the CP2E CPU Unit via 
USB port or Ethernet port. 
Set the clock if the timer function will be used. 
 

6. Test Operation 
Turn on the power and confirm operation is correct before starting actual operation. 
 
Precautions for Correct Use 

After replacement, please perform trial operation before starting actual operation and check that 
the system operates correctly. If the wiring or settings are not configured correctly, the system 
may malfunction. 
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Appendix 1. Specification and Performance Comparison Between CP1E and CP2E 

● Functional Specifications 
 

Item CP1E E/NS-type 
CPU Units CP2E E/S-type CPU Units CP1E N-type CPU Units CP2E N-type CPU Units 

Power supply AC power supply 100 to 240 VAC 
DC power supply 24 VDC 

Operation temperature 0°C~55°C -20°C~60°C 0°C~55°C -20°C~60°C 
Power supply to external 
devices (service power) 

Only AC power supply 
E/N30/40/60S CPU Unit: 
300 mA 

Only AC power supply 
E/S30/40/60 CPU Unit: 
300 mA 
E14/20 CPU Unit: None 

Only AC power supply 
N30/40/60 CPU Unit: 
300 mA 
N14/20 CPU Unit: None 

Only AC power supply 
N30/40/60 CPU Unit:  
300 mA 
N14/20 CPU Unit: None 

High-speed counter inputs ES-type: 
Up/down or pulse plus 
direction inputs: 
10 kHz × 2 counters 
Or 
Differential phases (4x): 
5 kHz × 2 counters 
Or 
Increment inputs: 
10 kHz × 6 counters 
10 kHz × 5 counters (Only for 
10 I/O Points) 
 
NS-type: 
Up/down inputs: 
100 kHz × 1 counter 
10 kHz × 1 counter 
Or 
Pulse plus direction inputs: 
100 kHz × 2 counters 
Or 
Differential phase inputs (4x) 
50 kHz × 1 counter 
5 kHz × 1 counter 
Or 
Incremental pulse inputs 
100 kHz × 2 counters 
10 kHz × 4 counters 

Up/down inputs: 
100 kHz × 1 counter 
10 kHz × 1 counter 
Or 
Pulse plus direction inputs: 
100 kHz × 2 counters 
Or 
Differential phase inputs (4x) 
50 kHz × 1 counter 
5 kHz × 1 counter 
Or 
Incremental pulse inputs 
100 kHz × 2 counters 
10 kHz × 4 counters 

Up/down inputs: 
100 kHz × 1 counter 
10 kHz × 1 counter 
Or 
Pulse plus direction inputs: 
100 kHz × 2 counters 
Or 
Differential phase inputs (4x) 
50 kHz × 1 counter 
5 kHz × 1 counter 
Or 
Incremental pulse inputs 
100 kHz × 2 counters 
10 kHz × 4 counters 

N14/20 CPU Unit: 
Up/down inputs: 
100 kHz × 1 counter 
10 kHz × 1 counter 
Or 
Pulse plus direction inputs: 
100 kHz × 2 counters 
Or 
Differential phase 
inputs(4×)  
50 kHz × 1 counter 
5 kHz × 1 counter 
Or 
Incremental pulse inputs 
100 kHz × 2 counters 
10 kHz × 4 counters 
 
N30/40/60 CPU Unit: 
Up/down or pulse plus 
direction inputs: 
100 kHz × 2 counters, 
Or 
Differential phase 
inputs(4×)  
50 kHz × 2 counters 
Or 
Incremental pulse inputs 
100 kHz × 3 counters 
10 kHz × 3 counters 

Quick-response / 
Interrupt inputs 

6 inputs 6 inputs 6 inputs 8 inputs 
(6 inputs only for 14 I/O points) 

Pulse 
outputs 
(Models 
with 
transistor 
outputs 
only) 

Pulse output 
method 

ES-type: Not supported 
NS-type: Pulse plus 
direction only 

E-type: Not supported 
S-type: Pulse plus 
direction only, 2 axes max. 

Pulse plus direction only 
2 axes max. 

Pulse plus direction only 
4 axes max. 

Speed control ES-type: Not supported 
NS-type: Supported 

E-type: Not supported 
S-type: Supported 

Supported Supported 

Positioning ES-type: Not supported 
NS-type: Supported 

E-type: Not supported 
S-type: Supported 

Supported Supported 

Origin searches ES-type: Not supported 
NS-type: Supported 

E-type: Not supported 
S-type: Supported 

Supported Supported 

PWM outputs (Models with 
transistor outputs only) 

ES-type: Not supported 
NS-type: 1 output 

E-type: Not supported 
S-type: 1 output 

1 output 1 output 

Analog I/O Not supported Not supported Supported (Only for NA20) Not supported 
Analog volume Not supported Not supported Supported Not supported 
USB port Provided. 

USB2.0 Full-speed (12M) 
Not provided 

Ethernet port Not provided Provided 
With switch function* 
* N14/20 is not supported. 

Built-in serial 
communication port 

ES-type: Not provided 
NS-type: RS-232C 
NS1-type: RS-232C and 
RS-485 

Provided. 
E-type: RS-232C 
S-type: RS-232C and 
RS-485 

Provided. 
N-type: RS-232C 

Not provided 
Provided by installing Option 
Board. 

Serial option board Not provided N14/20 CPU Unit: None 
N30/40/60 CPU Unit: 1 slot 

N14/20 CPU Unit: 1 slot 
N30/40/60 CPU Unit: 2 slots 

Serial 
communi- 
cation 
protocols 

Baud rate 1200/2400/4800/9600/19.2k/38.4k/57.6k/115.2k 
Supported 
protocol 

• Host Link 
• 1:N NT Link 
• No-protocol mode 
• Serial PLC Links (master, 

slave) 
• Modbus-RTU easy master 

• Host Link 
• 1:N NT Link 
• No-protocol mode 
• Serial PLC Links (master, 

slave) 
• Modbus-RTU Easy Master 
• Modbus-RTU Slave 

• Host Link 
• 1:N NT Link 
• No-protocol mode 
• Serial PLC Links (master, 

slave) 
• Modbus-RTU easy master 

• Host Link* 
• 1:N NT Link* 
• No-protocol mode 
• Serial PLC Links (master, 

slave) 
• Modbus-RTU Easy Master 
• Modbus-RTU Slave 
* PORT1 (EX) is not 

supported. 
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Item CP1E E/NS-type 
CPU Units CP2E E/S-type CPU Units CP1E N-type CPU Units CP2E N-type CPU Units 

Option Boards that can be 
mounted 

Cannot be mounted. • RS232C Option Board 
CP1W-CIF01 

• RS422A/485 Option Board 
CP1W-CIF11/CIF12-V1 

• Ethernet Option Board 
CP1W-CIF41 

• Analog Option Board 
CP1W-MAB221/ADB21/ 
DAB21V 

Serial Communication Option 
Board with one port 
• RS232C Option Board 

CP1W-CIF01 
• RS-422A/485 Option Board 

CP1W-CIF11/CIF12-V1 
Serial Communication Option 
Board with two ports*1 
• RS232C Option Board 

CP2W-CIFD1 
• RS232C & RS-485 Option 

Board CP2W-CIFD2 
• RS-485 Option Board 

CP2W-CIFD3 
Analog Option Board*2 

CP1W-MAB221/ 
ADB21/ DAB21V 

*1 CP2W-CIFD can only be 
mounted on option slot 1. 

*2 Maximum one Analog 
Option Board can be 
mounted on an N-type 
CPU Unit. 

Memory backup Built-in EEPROM: 
Contains the user programs, 
parameters, DM Area initial 
values and comment files 
 
Built-in SRAM (Battery 
backup): 
DM/HR/CNT/AR Data memory 
area 

Built-in Flash Memory: 
Contains the user programs, 
parameters, DM Area initial 
values and comment files 
 
Built-in non-volatile memory 
(Batteryless backup): 
DM/HR/CNT/AR Data memory 
area 

Built-in EEPROM: 
Contains the user programs, 
parameters, DM Area initial 
values and comment files 
 
Built-in SRAM (Battery 
backup): 
DM/HR/CNT/AR Data memory 
area 

Built-in Flash Memory: 
Contains the user programs, 
parameters, DM Area initial 
values and comment files 
 
Built-in non-volatile memory 
(Batteryless backup): 
DM/HR/CNT/AR Data memory 
area 

Clock ES-type: Not supported 
NS-type: Supported 

E-type: Not supported 
S-type: Supported 

Supported Supported 

 
 

Item CP1E CPU Units CP2E CPU Units 
Program capacity E-type: 2K steps 

N-type: 8K steps 
E-type: 4K steps 
S-type: 8K steps 
N-type: 10K steps 

FB capacity Not provided E-type: 4K steps 
S-type: 8K steps 
N-type: 10K steps 

Program language Ladder diagram Ladder diagram 
Function blocks Not provided Maximum number of function block definitions: 64 

Maximum number of instances: 128 
Languages usable in function block definitions: Ladder 
diagrams, structured text (ST) 

Instructions Approximately 200 Approximately 220 
Instruction execution times LD: 1.19 μs 

MOV: 7.9 μs 
LD: 0.23 μs 
MOV: 1.76 μs 

Number of tasks 17 
• 1 cyclic task 
• 16 interrupt tasks 

17 
• 1 cyclic task 
• 16 interrupt tasks 

Maximum subroutine number 128 128 
Maximum jump number 128 128 
Scheduled interrupt tasks 1 1 
CIO Area 4,640 bits (290 words) 

CIO 0.00 to CIO 289.15 (CIO 0 to CIO 289) 
4,640 bits (290 words) 
CIO 0.00 to CIO 289.15 (CIO 0 to CIO 289) 

Work Area (W) 1,600 bits (100 words) 
W0.00 to W99.15 (W0 to W99) 

2,048 bits (128 words) 
W0.00 to W127.15 (W0 to W127) 

Holding Area (H) 800 bits (50 words) 
H0.00 to H49.15 (H0 to H49) 

2048 bits (128 words) 
H0.00 to H127.15 (H0 to H127) 

Auxiliary Area (A) Read-only: 7,168 bits (448 words) 
A0.00 to A447.15 (A0 to A447) 

Read/write: 4,896 bits (306 words) 
A448.00 to A753.15 (A448 to A753) 

Read-only: 7,168 bits (448 words) 
A0.00 to A447.15 (A0 to A447) 

Read/write: 8,192 bits (512 words) 
A448.00 to A959.15 (A448 to A959) 

Temporary Area (TR) 16 bits: TR0 to TR15 16 bits: TR0 to TR15 
Counter Area (C) 256 timer numbers: T0 to T255 256 timer numbers: T0 to T255 
Timer Area (T) 256 counter numbers: C0 to C255 256 counter numbers: C0 to C255 
Data Memory Area (D) E-type: 2K words D0 to D2047 

N-type: 8K words D0 to D8191 
E-type: 4K words D0 to D4095 
S-type: 8K words D0 to D8191 
N-type: 16K words D0 to D16383 

Data Registers (DR) Not provided 16 registers: DR0 to DR15 
Index Registers (IR) Not provided 16 registers: IR0 to IR15 
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Appendix 2. Expansion Units, Option Boards, Cables, Batteries 
● CP1W Expansion Unit 
The CP1W Expansion Unit can be used with the CP2E. 

Product CP1W Expansion Unit Remarks 
I/O Unit with 40 I/O points CP1W-40EDR1  

CP1W-40EDT  
CP1W-40EDT1  

I/O Unit with 20 I/O points CP1W-20EDR1  
CP1W-20EDT  
CP1W-20EDT1  

Input Unit with 8 inputs CP1W-8ED  
Output Unit with 8 outputs CP1W-8ER  

CP1W-8ET  
CP1W-8ET1  

Output Unit with 16 outputs CP1W-16ER  
CP1W-16ET  
CP1W-16ET1  

Output Unit with 32 outputs CP1W-32ER  
CP1W-32ET  
CP1W-32ET1  

Analog Input Unit CP1W-AD041  
CP1W-AD042  
CP1W-DA021  

Analog Output Unit CP1W-DA041  
CP1W-DA042  

Analog I/O Unit CP1W-MAD11  
CP1W-MAD42  
CP1W-MAD44  

Temperature Sensor Unit CP1W-TS001  
CP1W-TS002  
CP1W-TS003  
CP1W-TS004  
CP1W-TS101  
CP1W-TS102  

 
● Option Boards 
All CP1W Option Boards except the CP1W-CIF41/DAM01 can be used with the CP2E. 

Product CP1W Expansion Unit Remarks 
Option Boards CP1W-CIF01  

CP1W-CIF11  
CP1W-CIF12-V1  
CP2W-CIFD1 For CP2E 
CP2W-CIFD2 For CP2E 
CP2W-CIFD3 For CP2E 
CP1W-ADB221  
CP1W-DAB21V  
CP1W-MAD221  
CP1W-CIF41 Cannot be used 
CP1W-DAM01 Cannot be used 

 
● Others 
Compatible batteries have changed from the CP1E. 

Product CP1W Expansion Unit Remarks 
Battery CP2W-BAT02 The CP1W-BAT01 cannot be used. 
Extension cable CP1W-CN811  
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Appendix 3. PC System Setting Examples for Transitioning from CP1W-CIF41 to CP2E-N 
The CP1W-CIF41 cannot be used with the CP2E. Use the built-in Ethernet function of the CP2E-N. 

 
Model being replaced: CP1W-CIF41   
Web browser settings screen 

Model used for replacement: CP2E-N 
PLC Setup settings screen 

Ethernet Settings 

  
 
1. IP Address and Protocols → System 

 
 

Ethernet Settings 
Built-in Ethernet Tab 

 
 

 
 

 

IP Router Table Settings 

 
 
2. IP Address/Router Table → IP Router Table 

 
 

IP Router Table Settings 
Built-in Ethernet Tab → Ins under IP Router Table 
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Model being replaced: CP1W-CIF41   
Web browser settings screen 

Model used for replacement: CP2E-N 
PLC Setup settings screen 

FINS/TCP Settings 

 
 
1. IP Address and Protocols → System 

 
 
3. FINS/TCP → Connection 

 

FINS/TCP Settings 
Built-in Ethernet Tab → FINS/TCP Setting 
 

 
 

 
• The CP1W-CIF41 supports FINS/TCP servers only, so 

make sure to check Server. 
• The CP1W-CIF41 does not support the keep-alive 

function. Check this option if the function is required. 
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Model being replaced: CP1W-CIF41   
Web browser settings screen 

Model used for replacement: CP2E-N 
PLC Setup settings screen 

FINS/UDP Settings 

 
 
1. IP Address and Protocols → System 

 
 
2. IP Address/Router Table → IP Address Table 

 

FINS/UDP Settings 
Built-in Ethernet Tab → FINS/UDP Setting 
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